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What Reports are available in InRoads?
 Reporting can be accomplished in several ways:
— Review type reports
 Presentation / formatting controlled by the product
— XML/ XSL reports

* Presentation / formatting controlled by the user (as defined in a style sheet /
XSL file)

* InRoads produces the XML data

* InRoads Report Browser utilizes XSL to transform the XML data to text or
HTML
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B
Understanding XML

 Extensible Markup Language (XML) composed of tags
and attributes and XML Is used for data exchange

« Extensible Stylesheet Language Transformation (XSLT) -
— Defines the presentation of an XML document

« XML must be well formed

 One root element with a unique name

 Elements are properly nested -- no overlap.

« Tags must be closed.

« XML Is case sensitive

« All element attributes are enclosed in quotation marks

=z Bentley



What Can Style sheets Accomplish?

Transform XML into HTM, text or another XML.

Filter anc

Address

Format XML data basec
negative

narts of an XM

sort XML data.

| document.

on the data value, like displaying

numbers In red.
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e
XSL Elements

* Xxsl:apply-templates
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o xsl:attribute

o xsl:call-template

» xsl:choose

o Xsl:comment
e Xsl:copy

e Xsl:copy-of
o Xsl:element

o Xsl:for-each
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e
XSL Elements Continued

o XSl:if
o xsl:include

o Xsl:otherwise

o Xxsl:output

e Xxsl:param
e Xxsl:sort

o Xsl:stylesheet
 Xsl:template

o Xsl:text
= Bentley
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B
InRoads XML Report Too

* To Access select InRoads > Tools > XML Report

« The Report Tool Extracts an XML file from the InRoads
binary data structures based on the criteria submitted.

« The XML file is temporary and written to the location of the
systems TEMP variable

« Save any files to be reused to alternate location.
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B
Report Browser

e Manage “default” report style sheet for each type of report
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o Style sheet “Help” documents what is required to use a specific
style sheet

« Manage formatting with Tools>Format Options
— Decimal precision
— Formatting
« Stationing
« Angles
* Directions
* Slopes

Allows multiple looks at the same data

8
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B
Report Browser

E Bentley InRoads Report Browser -

Temp'RPT849.2ml

File Tools Help

|D:\plogram files\BentleyynR oads Group V8.11%ML Datal

|7 Evaluation

{5 Geomety

Area.xs!

ControllineD ata. sl
Horizontaldlignmentandk vents xzl
HorizontaltlignmentCurves etR eview. ksl
Huorizontal&lignmentD ata. xsl
HarizantaldlignmentLengths.<sl

Harizantal&lignmentR Style Sheet Help

Project:
Description:
File Hame:

Horizantalsfignmentsi Set as Default Surfaces

Last Revised:

Input Grid Factor:

Horizontal Alignment Review

Report Created: 10/11/2007
Tirne: 2:45pm

Rarnp E-287

Diidata\Ramp E287 - Prestressed Concrete
Richard. Eradshaw 10/11/2007 2:26:40 PM

1.00000000 Mote: Allunits in this report are

Horizontaltndyertical

Set as Default Surface Check

Format Options

Mode

Morthing/E asting:

Elesvation:

X
Cloze |
Help |

Farmat

Frecision

Angular: Degrees

Slope:

Uze Alternate Slope if Slope E xceeds:
Alternate Slope:

Linear:

Station:

Acres/Hectares:

Area Urits:

Cubic: Urits:

j Ig j Iddd“mm'ss.s" | I Include Angular Suffis
joazas | |[s0% =l
I'IU.UUUUX
jo =] Jzoa |

=
C—

il ~| ¥ Convert ta Cubic Yards

Drirection: I Bearings

Face:

=l o
Wertical Dbservation: m

j I ddd"mm'sz.s" j

HorizontalE lementsT 2

HorizontalE lementsy
HorizontalE vents. sl
Harizantalnterpalatec
ListCoordinates. <zl
ListCoordinatesStation
ProfileStationE levatiol
ProfileStationE levatiol
ProjectAlignmentListin
Project&lignmentListin

Set as Default Station and OFfset

Set as Defaulk Clearance

Set as Default Skakeout

Set as Default Legal Description

Set as Default Map Check

Set as Default Intersecting Alignment Stations

Set as Default Horizontal Annatation Tabling

Alignment Name: Rarmp E-257
Alignment Description:
Alignment Style: Default

SettingDutT able. ksl
SlewDiagram.xsl
SlewDiagramlLegacyF
Traverse.rsl
TraverseCureedSClL:
TraverseCurvedSCI 2

: f:“lf;“lf3“If:“'If:“If:“'If:“lf;“ﬂf:“'lf:“'lf:“lf:“lf:“lf;“'\fa“lf:“lfm'lf:“lfm'lfmf:“‘l

Set as Default Cant

Set as Default Turnouts

Set as Default Light Rail Manufacturing
Set as Defaulk Horizontal Slew

Set as Default Yertical Slew

TraverseCurveASCIE

Set as Default Bridge

TraversePoints.xsl

Yerticaldlignment3Pel
Verticaldlignmentandl
VerticalblignmentPoin
VerticaldlignmentRew

Set as Default Cross Section
Set as Default End Area Yolume
Set as Default Triangle Yolume
Set as Default Roadway Yisibilicy

VerticalalignmentB ev
YerticalalignmentRey

Set as Default Survey

YerticaldlignmentSigh
‘WerticalE vents. xsl
VerticallnterpalatedSh

Set as Default Roadway Design
Set as Default Superelevation
Set as Default Template Library

YerticalSlewDiagram ST

|
Images
|

Leaall ezcriotion

ntersectingblignmentStations

Station Northing Easting
Elerment: Linear
POB {pi) B+50.00 3925827 606 2055511.372
PC @] g§+469.27 392895 958 2056019.715
Tangential Direction: M F1*60M2" E
Tangential Length: 219,269
Element: Circular
PC @] g§+459.27 3925895 958 2056019.715
Pl 9] 10+54.63 392953.740 2056195.840
cc [} 391534.937 2056466.231
PT () 12+37.94 392964 786 2056380.572
Radius: 1432354
Delta: 14°44'49" Right
Degree of Curvature (Arc): 4<0000"
Length: 368.674
Tangent: 185.361
Chord: 367.657
Middle Ordinate: 11.845
External: 11.944
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B
Geometry Report Types Avallable

« (Geometry
+ Station Base
o Station Offset

o Clearance

o Stakeout

 Legal Description

« Map Check

* Intersecting Alignment Stations

« Point Validation

Z Bentley



B
Geometry Report

Station  Elevation Northing Easting

Element: Linear
FOB E+50.00 B28.140 392827 BOB 2055811.372
PG B+74.00 B27 545 392835 067 2055834176 |
Tangent Grade: -2 4800%

; . . . Tangent Length: 24.000
Horizontal and Vertical Alignment Review Report

Element: Symmetrical Parabola

Report Created: 10/11/2007 PVC  B+7400  B27545 392835087 2055834176
Time: 2:52pm Pvl  B+48.00 623230 392889328 2055999506 [
Priject i 267 PYT 1042200 625293 392935749 2056167.097
Dokoretion: VLOW 940944 BR4E6
escription:

Length: 343.000
Entrance Grade: -2 4800%
Exit Grade: 1.1856%

File Name: Didata\Ramp E287 - Prestressed Concrete\Ramp E-287 .aly
Last Revised: Richard.Bradshaw 10/11/2007 2:43:18 P

Input Grid Factor: 1.00000000 Hote: Al units in this report are in feet unless specified otherwi==
=I5
— Harizantal Alignments———————— [ Cogo Paints _m
Horizontal Include: Ix ﬂ Include: I ﬂ
Alignment: Rarnp E-257 5 ) ) Close |
elected: Selected:
Hor_lzu_ntal W ame | sityle |=] Mame | Description | Style | Filter... |
Description: PED238 pedestal
Horizontal Style: Default PED233 pedsstal m
FED300 pedastal
Station Northing Easting Fiamp E-287 Diefault Help |
Sa slab
Element: Linear gig E:ZE
POBE [ pi0) G+50.00 39527 606 2055511.372 gig S:ag j
P () B+50.27 3925855 953 20656018.715 =
Tangential Diraction: MN71%012"E ¥ Include Vertical Alignments | ISU.UU ﬂ
Tangential Lergth 219.269 ool @l Clis
[ Inchide Cant Alighments = Gtation
Element: Circular GIAI € fctive i IW ﬂ
P 8] B+H69.27 392895 958 2056012.715 ¥ Include Vertical Event Paints Stop: W ﬂ
Pl 8] 10+54.63 392953.740 2056195.840 Iv Include Herizontal Event Paints
[ 8] 3534937 2056465231
PT () 12+37.84 39259654786 2056350872
Radius: 1432.394
Delta: 14°44'49" Right
Degree of Curvature ..
1 1 (Arcy 470000

Lenath: 355 674 ~
Z5/Bentley
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B |
Station and Offset

« Why two commands Station Base and Station Offset?

o What's the difference?

— Primarily it has to do with whether you increment along the
active alignment / feature or the selected alignments /
features
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B
Station Base Report

* Increments along the From object

© 2010 Bentley Syst

* Allows you to define station limits

i
5 Station Base Report = From
- % General ' Horizontal Alignment: I B aseling ﬂ ﬂ
Include Transverse Feature Report
Hoi i i Surface: IDesign j
orizontal Alignments
) Report Created: 10/15/2007
Features Feature: [Dobte Track-100am 0000 ~] 4] Time: 11:38arm
i~ Limits
I™ Station Rail Modelingrailway. aly
Start: IW ﬂ | Bradshaw 10/15/2007 11:23:38 AM
oo Hote: &l units in this report are in feet unless specified otherwize
Stop:  [133+75.0000 +|
tation Offset Elevation Northing Easting
0-+10.00 -35.628 101.838 10344 231 4554 046
0-+00.00 -33.5683 100.518 103542 BES 4592731
0-+00.00 -31.583 100.816 10341133 4591 445
Prefarsnoss, | Class Help 0+0000 27583 102816  1033B0BY 4538675
0-+10.00 -2B12F 103.544 10336 954 4587 939
Diouble Track-LE4 100-+00.00 -24.386 103.616 10335 620 4586.520
Double Track-LB1 100-+00.00 -20.083 105.768 10332 323 4504.054
Double Track-SBLT 100-+00.00 -14.750 104.018 10528238 4580625
Double Track-LB2 100-+00.00 9417 105.763 10324152 AS7T 197
Dauble Track-Bl 100-+00.00 -7.375 104.747 103522 5838 4575.885
Double Track-SB1 100-+00.00 -7.375 104.325 10322 588 4575.885
Double Track-SBS 100-+00.00 -7.375 103.658 10522 588 4575885
1 3 Double Track-RB1 100-+00.00 -5.333 105.763 10321.024 A574 573
Fomieln Tomals 0BT 1AmAA nn AAnn ama Ae AnSaE Amn AETA A 44

2z Bentley
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B |
Station Offset Report

* Increments along the Selected object
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151
{23l Station Difset Repart Fram

- 8 General %" Harizontal Alignment: IBaseIine =] ﬂ

- Include

€ Suiace: - —

e Horizantal Alignments HiaeE I design J

v Featues Feature: [Double Track-100+000000 +] #]
Apply Preferences. . Cloze Help

14
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B
Clearance Report

« Computes station and offset from actual data

— Horizontal cardinal points
— COGO points
— Features
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o ] 3
a Clearance Feport i~ From
- 8 Genera I %" Harizontal Alignment: IBaseIine =] ﬂ
e Huorizantal &lignments ; -
e Cage Paints ® i [ Desian K
o Featues Feature: [Dobte Track-100am 0000 ~] 4]

I Event Stop: [[133+75.0000 +|

i~ Include Horizontal Paints Limits
¥ On-&lignment [ Station
I~ Oif-lignment Start: [00+00.0000 #]

i Preferences... | Cloze | Help |

15
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B
Stakeout Report

¥ Stakeout Report i ] 4|
5 Stakeout Report ~ Fram
& General * Horizontal Alignmert: ITlaverse j ﬂ
Harizantal Alighments e . )
. Occupied Point:
- Cogo Paints B I j ﬂ
...... Features Backsight Paint: I j ﬂ
i~ Include Horizontal Points
¥ On-alignmert [~ Off-alignment
[ Event
v Interval |5u_gggu ﬂ hterline Stakeout Report
I Oftset:  [50.0000 #| Report Creatsd: 10/15/2007
Time: 12:25pm
Il Madelingtraibway. alg
adshaw 1041572007 12:24:09 P
Hote: &l units inthis report are in feet unless specified otherwise.
Apply Freferences... Cloze Help
Offset From
Centerline BS ocC FS Station Angle Right Distance
0.000 trl02 trel 01 100-+00.00 3257252 133.880
0.000 trv102 trl 01 102-+10.00 35972037 296,628
0.000 trv102 trl 01 103+50.00 B2019" 439.986
0.000 w101 trel02 111+75.00 194°34'32" 293.204
0.000 trl02 tre103 113+25.00 2B724724" 270616
0.000 103 trel 04 120+25.00 30°37°32" 215.664
0.000 trv103 trel 04 121+75.00 B0®55108" gv.178
0.000 trv104 trel 05 127+75.00 301°1114" 114.603
0.000 tr104 trel 05 129+25.00 247°4912" 186.858
0.000 105 trel 06 133+75.00 32°23%0" 115.544
1 6 0.000 trv102 trvl 01 100-+0.00 325%2512" 133.880

z5Bentley



B
Legal Description Report

 Simple boundary
— Includes typical distances, bearings and curve data
— Includes areas
— Includes closures
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* Right-of-way takes & easements

— Include references (i.e. station & offsets) to multiple
alignments

17
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B
Legal Description Report

?Legal Description Repork ;IEILI
i~ Alignments i~ Primary Reference Alignment——————— Apply

Inchide: I"take ﬂ v Include
Cl H .

Selected: Mame: l—_,ASTHBS_cI = ﬂ 0se . Alignment Pla.me. Parcel 101-Take

Marne | Style | Bandwidth: [100.00 ﬂ Filter. . Alignment Description:

Parcel 101-Take

ty_li
Parcel 102-Take EIEE::t:ZI::E Preferences... Commencing at 32,
FParcel 103-Take praperty_line - Secondan Reference Alignments Help said point being the POINT OF BEGINNING;
Inchude: I ﬂ thence 5 90°0000" E, 53.772 feet,
thence 5 0°0000" W, 52,202 feet,

© 2010 Bentley S

Lk

Selected:

— to a point on & curve 36,
Name | Description | Stje | having a radiug of 153,700 feet and a central angle of 19°69°27",
thence along the arc of said curve a distance of 83,627 feet,
¥ Closed Alignments Onlg gaid arc subtended by a chord bearing N 37°36'%4" W, a distance of 53.356 fest.
thence M 31°2327" W, 10,154 fest,
™ Include Block Parent Alignment thence M 29°3147" W, 8.044 feet,
Name: thence M 25°54720" W, 8.726 fest,
 [Parcel 103 o thence M 19°4519" W, 13.052 feet,
thence N 1627 56" W, 10.635 feet,
- ~ thence M 10°1700" Wy, 4.001 feet.
Alignment Description: and the POINT OF BEGINNING; Containing 0,083 acres, mare or less,

Beginning at a point 16129 feet left of ASTHE3 ol at Station 1443023 thence 3
070000" E a distance of 53.772 feet to a point 35.910 feet right of ASTHI3 ol at
Station 1448054 thence S 090000" W a distance of 92 202 feet to a point 11.000
feet left of ASTHES cl at Station 13+90.92 thence alonyg an arc 53.627 feet to the
right, having a radius of 153,700 feet, the chord of which is M 373654 W far a
distance of 53.356 fest, to a point 11.000 feet left of ASTHES cl at Station
14+40.71 thence M 31°2327" W a distance of 10.154 feet to a point 12.000 feet
left of ASTHE3_cl at Station 14+50.06 thence N 29°31'47" ¥ a distance of 5.044
feet to a point 13.000 feet left of ASTHES _cl at Station 14457 40 thence N 25°
54°20" W a distance of 5.726 feet to a point 14.000 feet left of ASTH33 cl at
Station 14+65.32 thence N 19°4519" VW a distance of 13.052 feet to a point
15.000 feet left of ASTHE3_cl at Station 14+77.14 thence M 16°27'56" W a
distance of 10.638 feet to a point 16.000 feet left of ASTHEI _cl at Station
14+86. 69 thence M 10°1700" W & distance of 4.001 feet to a point 16.129 feet left
of ASTHE3_cl at Station 14+30.29 and the POINT OF BEGINNING.

The above described parcel contains £ 0.089 acres (3022 sg. ft.)

18
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B
Map Check Report

 Multiple parcels at one time
 Curvilinear & angular data is rounded

Pl Name: 3o feBorteflionds 6103 V0 11Sarle ﬁ
Last Revised: Richard.Bradshaw 10/11/2007 1:42:10 P
In|:|FL:chrit_1 100000000 Hote: Allunts inthiz report are ;Iglil
~ Alignments 4'
Include: I ﬂ i
Alignment Name: Elite Center Sel n Close |
Alignment Description: Property Boundary slected .
M ame | Description | Stule | Filter... |
POB (1) 10038.683 973,608 Elite Center  Property Bo... property_li... Preferences.. |
3 89°4000" W 252.54
Pl (2) 10037214 9521.072 Help |
M 0%6502" E 360.09
PI(3) 10357 254 9526.837
M 89°4000" E 210.58 Output Pregision———
Pl (4) 10398.479 9737 394 Linear: |u_12 v[
5 26°5150" E 20.04 [T
Pl (5} 10318.152 9778.082 V¥ Closed Aligrments Orily irectior: ID :I'
506502 W 279.50
POE (1) 10038.683 9773508  0.000
Northing Error: 0012 ft
Easting Error: -0.003 ft
Closing Direction: S 11%86%6" E
Closing Distance: 0013 1t
Closed Area: 89223 sqft 2 ac
Perimeter: 1182735 ft
1 9 Precision: 94586.253

|
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Intersecting Alignment Stations Report
« Complements Drafting > Intersecting Alignment Note

EEEEE———— CPT (4] 248434 2718
Element; Intersection Point

Puoint on |-70CL: 293464 1663
Foint on RampA_Lt 02 10+41.3649

Element; Intersection Point

Puoint on |-70CL: 293489 4762
Foint on RampA_Lt 01: 15+26.7274
20 = (23] 293497 2929

170

170

Tlntersecting Alignme

Horizontal Alighmet; I I-700L j ﬂ
— Interzecting Alignments
| niclude: Ix ﬂ
Selected:
M ame | Dezcription | :l
Famp H B/14/01 wcy
R ampd,_Lt_01 vy -1 2-02
Rampd,_Lt_02 vacyd-12-02
R ampd_Rt_01 w1202
FampH_LT_M w1802
RampH_RT_01 w1802
ex ramp & azb 2 ex. ramp & [R... LI

0] x|
Apply
Cloze

Filter...

dil:

Help

170745765.3922 3101050 6055

1707584.2083 3101050, 5062

v
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B
Surface Report Types Available

o Surfaces
« Surface Check
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B
Surfaces Report

* Pretty basic reporting, since most surface data Is
related to cross-sections, volumes, etc.

SIETEY
Surface: I

Mame | Degcription -
Drefault Cloze |
existing Graded Roadbed =
Diesign Created from roadway... Filter... |
April BBl
b ay bz Built F'referenc:es...l
June &g Builk

Help |
Features:
MName Style Description = ﬂ

Breakline Featurel Default

Breakline Feature10 Default

Breakline Featurel1 Default

Breakline Feature12 Default

Breakline Featurel3 Default

Breakline Feature14 Default

Breakline Feature2 Default

Breakline Feature3 Default

Breakline Featured Default

Breakline Featureh Default hd
1| | 3

¥ Include Feature Points

22
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Surface Check Report

o
. . pa"zear:em 7648007 9341183 13n70s| 130705|  oooo| BELOW oom| N foavement
i Q u a Ity C h e C kl n g Of a S u rface pa";argem eeg A%6| gazeany| 1aness| 1m0sss|  oooo| BELOW pooo| N [pavement
pa";a'ge"‘ 7eon.eeE| 9:E.431| 131.080|  131.080 n.ooo| BELOW oooof N [pavement
to al OWable toleranCeS Points Outside of DTM
Total Points Qutside [ 0 |
L] L ]
. SII I |I ar tO COI I Ipare Surface Sy

Group 1| Group 2

Points 170 136

In Tol 170 136
Out of Tol ] 1]
% In Tol 100% 100%
% Out Tol 0% 0%

Max Above | 0000 0.000

?5urface Check Report Max Below | 0000 | 0.000

Surface; IDesign j Apply |
i~ First Check Paints rSecond Check Pointe————————— Clase |
Include: I ﬂ Inelude: ﬂ
Selectad: Selectad: filter: |
Mame | style | | Mame | style | -] Preferences. . |
Ground 101 graund ! Pavement 101 pavement ]
Ground 102 graund Pavement 102 pavement Help |
Ground 103 ground Favement 103 pavenment
Ground 104 ground Favement 104 pavement
Ground 105 ground Favement 105 pavement
Ground 106 ground Favement 106 pavement
Ground 107 ground Favement 107 pavement
Ground 108 ground Favement 108 pavement
Ground 103 ground LI Favement 109 pavernent LI
Talerance: 0.2000 Talerance: 0.0100

23
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B |
End-Area Volumes

o \olumes from cross-section sets

?End—nrea Yolumes o ] 3
File
Ciiere Sealiian Sl Object | Source | Parent | Elassification| Mazs Ordinate | Cut Fact0l| Fill Factar |
= exizting Surface 1.0000 1.0000
IBaseIlne j ﬂ B allast Component Design Designed Exclude 1.0000
{3 Endviviea Volumes Subballazt | Component Design Designed Exclude 1.0000
General
- Unsuitable M aterialz by Feature
il
File
Crass Section Set: Surface | Tupe I [ etes
IBaseIine j ﬂ exizting Existing & Standard
=3 Endioa Volumes Design Deesign " Comect for Curvature
m = -r-al Materials by F - Station Lirnits
----- rzuitable M atenials by Feature . ..
----- Unsuitable Materials by Station I Use Station Limits
----- Classifications Start Station: Iﬁ 0+00. 0001 - ﬂ
----- Compaction/E xpansion
----- Wolume Exceptions Stop Station: |1DD+DD. oo ,l ﬂ
----- Added Quantities
..... Forced Balance . . Apply Freferences. .. Cloze Help
_____ s Bl Impenial Units
..... Arnatation ’7{" Cubic Y'ards {* Cubic Feet lgnore Areas Smaller Than: ID
v Create xML Report
Apply Preferences... Cloze Help

24
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Multiple looks at the data

o \olumes

Adjusted Included in Mass I7)
Station Type Area Volume Factor Volume Mass Ordinate? Ordinate >
100+00.00 0 E
Maormal Cut: 133 0 1.000 0 Yes g
[ G rade bOOk MNormal Fill: 5 a 1.000 1] es §
Added Cut: 0 1.000 0 ‘fes ©
Added Fill: 0 1.000 1] Yes
Ballast: 50 0 1.000 0 Mo
° M any Style Sheetsl Subballast: 26 0 1.000 0 No
n
101+00.00 278
Maormal Cut: 79 393 1.000 393 fes
Mormal Fill: 56 115 1.000 115 Yes
Added Cut: 0 1.000 1] fes
---------------- Station Quantities - - - -« - - - - - .. ... u 1.000 u Yes
Baseling  ---------- T Fill oo Mass fed ~ 100 194 Ng
Station Factor Area Volume Adjusted Factor Area Volume Adjusted Ordinate %6 1.000 96 Mo
100-+00.00 1.000 133 1] 0 1.000 5 a 0 1]
101-+00.00 1.000 79 393 3593 1.000 56 114 115 278
101+26.05 1.000 166 166 1.000 444 444 0
102+00.00 1.000 14 173 173 1.000 193 452 462 -1
103+00.00 1.000 5 7 7 1000 14 618 618 552
103+50.00 1.000 43 45 45 1.000 a1 177 177 724
104+00.00 1.000 67 102 102 1.000 34 78 78 700
105-+00.00 1.000 133 3o 370 1.000 0 G2 B2 353
105+77.591 1.000 393 3593 1.000 a 1] 0
106-+00.00 1.000 140 a04 504 1.000 0 a ] 11
107 +00.00 1.000 23 3m 30 1.000 29 a4 a4 355
107 +54.53 1.000 27 27 1.000 386 3586 1]
108+00.00 1.000 i 43 43 1000 294 555 595 187
109-+00.00 1.000 1] 1] 1] 1.000  6O7 1669 1669 -1866
110-+00.00 1.000 0 1] 1] 1000 963 2907 2907 4773
111+00.00 1.000 a0 a0 a0 1.000 1044 cra Eral -8450
111+75.00 1.000 0 0 0 1.000 800 2561 2561 -11051
112+00.00 1.000 1] 1] 1] 1.000 G683 589 steE] -11740

25
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End-Area Volumes & As Builts

« 15tmonth (yellow)

o 2"dmonth (green)

— Computed to design
lines not over-
constructed lines!

File:

Cross Section Sef:

61 v| #

{23 End-dwea Yolumes

Unzuitable Materialz by Feature
Unzuitable baterials by Station
Clazzifications
Compaction/E xpanision
“Yolume Exceptions
Added Quantities
Forced Balance

g Az Built
Annotation

Settings

Compute &5 Built Yolumes

Az Built Surface:

Include Previous &s Built Suface: | &5-Built_1

| sBuit_2 |

EoX

Apply ] [Pleferences. " ] [ Cloze

] [ Help

26
Z Bentley

=
%)
=
2
>
(2]
>
<
=
o
7}
(aa]
o
—
o
3¢
©




B
Mass-Haul Diagram

« Save the results of End Area
Volumes in the Report Browser
. Main | Tite | Grid | Awes |
(as a .xml file) |

ID:'\temp\volumes. sl

r Direction

* Load the XML file in Mass-Haul oo [ o
C RighttoLeft | |Vetical  [ooion

Diagram to display the diagram ...

% Cubic Yards " Cubic Feet

Sumbology:

Qbject | Hame | |
Data Line [l

Apply Preferences. .. Cloze
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B |
Other XML files

* XIN
o |TL

* |IRD
— Which can be loaded into the Report Browser
— Also now accessible through Roadway designer
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B
Report Browser & .XIN

Missing Named Symbologies Report

Report Created: 10/15/2007
Time: 9:43am

Missing Named Symbology Used By Type
Lane line FeatureStyle

Named Symbologies Use Report

Report Created: 10/15/2007

Time: 9:44am
Named Symbology Used By Type
abutment
abutrment Geometry Line Feature Style
Aggregate
Aggregate Surface Feature Style
Annotation-Plan
Default YiewSurfaceElevations Preference
Default YiewSurfaceElevations Preference
Default YiewClosedArea Preference
Default StationBaseClearanceAnnotation Preference
Default StationBaseClearanceAnnotation Preference
Default GeneralTracking Preference
Default GeneralTracking Prefarence
Annotation-Profile
Annotation-XCS
Ballast
Ballast Surface Feature Style
Base
Base Surface Feature Style
BB
BB Surface Feature Style
EB Survey Feature Style
BBERM
BEERM Survey Feature Style
BBOARD
BBOARD Survey Feature Style
BC

29 B Survey Feature Style

29 | WWW.BENTLEY.COM
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B
Report Browser & .IRD

e File>Open

File Name: D:MdataiRail Modelingiraibway.ird

Corridor: Single Track

Template: Single Track - Tangent - Ballasted
Start Station: 100+00.00  Interval: 10.000000

Component: Ballast

Description:
---- Constraints - - - -
Point Marme X ks Type “alue Parert Slope Wi dth Delts v
Horizontal -6.250  PoL
Bz 5280 0.563 Vector 5250  Left Rail
S0.0000% -4 206 -2.148
Slope S0.0000% B2
v 5548 273 Slope 41867%  SB1
4 AGET % 9.545 0308
5B noon  zasa  NonE
MHone
- 1GET % 9.545 -0.z308
Slope -AEET % SB1
B4 9.545 272
Slope -50.0000% BS
-50.0000% -4 206 2148
Harizontal 5250 PoL
o JE30 0ges Vector 5250  Left Rail
0.0000% . 0,000
10,500
Component: Subballast
Description:
---- Constraints - - - -
Point Marme X Y Type “alue Parert Slope Wi dth Delts v
5B nooo  zasa  onE
Hane
4 AGET Y ) 0421
11.545
- Slope S0.0000%  SB3
582 11.545 2814 Slope GAGE7 % SB1

30 | WWW.BENTLEY.COM
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Additional information in the XML Data directory

« ASCII output Style sheets
—Creating ASCII Output Style Sheets.pdf

e[nclusion of an XML in an XML
—XML Lookup Table Style Sheets.pdf

Supportive files

* Report element formatting
— format.xsl

—Raw-xml.xsl
—ShowAll.xsl

31
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B
Style Sheet Modifications

» Look at the schema
— XML Data\en\Schemas
— Only in English

 Look at style sheets that are close to what you want!
— Itis always easier to start from something than nothing!

« Look atthe Raw-xml.xsl to verify the data required is
available in the similar report.

« Make a copy of close XSLT that contains the data.

« Open that copy in your preferred XML editor
— Notepad ++ Is great and free!
— http://notepad-plus-plus.org/
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What's next?

« Testyour XSLT!! Think of all the ways your users will
run it.
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« Edit the help so that end users of the report will be able
to run it successfully

« |f you want a special java script solution or HTML
solution search the web for examples

« For XSLT help search Google
« Check out

a Great source!
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http://www.w3schools.com/xsl/xsl_summary.asp�

Lets take a look
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